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About Release 5.0 
The core of OptionFinder for Windows is complete, replicating the capabilities 
of v4.2 onto a technology and development platform that will take us into the 
future. At the time of this release, in addition to replacing v4.2 in a 32-bit 
Windows technology, the framework is in place to support process and 
presentation enhancements with very little change to the user interface or data 
structures. You can look forward to updates approximately every six months as 
tantalizing process and presentation enhancements are added to the platform. 
Check our web site (www.OptionFinder.com) periodically for the availability of 
upgrades. 

We invested heavily into the Help system and we hope you enjoy, as well as use 
it. Unless we missed a few, there is a “What’s This?” context-sensitive help for 
every control on every dialog. There is also a good index, table of contents, 
glossary and hypertext navigation system. This too will improve as the system 
evolves and we hear from our users. 
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About This Guide 
Maybe you just received your OptionFinder system and need to use it 
before you get your training, or you want to learn the basics of 
OptionFinder on your own so you can concentrate on the advanced 
features when you get your OptionFinder training. Most likely though, 
you are an experienced user and want to learn OptionFinder 5 for 
Windows or just brush up, since it has been a while since you last used it. 
This guide takes you through setting up and running an imaginary 
meeting that requires using OptionFinder’s often-used features and 
functions. 

Here’s the situation: Your boss just volunteered you to prepare and run 
OptionFinder as part of an important HR initiative. He said, “We need 
you to put together a series of workshops where our employees tell us 
about their working environment. And we need it to start next week, 
eight four-hour workshops in several cities over a two-week period.  Our 
deliverable is a written and presented report to the board at their meeting 
in three weeks in Singapore. I told the president you could do it with 
OptionFinder, but that you would need some serious R&R when it is 
over. Here’s the deal: plane tickets for two, and two weeks to get home. 
What do you say?”  

Use this guide as the place to start. It leads you through the basics of 
building and running the OptionFinder-supported workshops required for 
two weeks of nirvana. Along the way you will be setting up many of 
OptionFinder’s most used features. There is a short version of this Guide 
in the help system (pull down Help/Contents/Getting Started/Learning by 
Example) with links to relevant, related topics. 

 

After working through this guide, you will still need to practice. This 
guide will not make you an expert, but it will show you what you need to 
know to get through those workshops over the next few weeks. It will 
also give you a head start towards becoming an expert is using the 
OptionFinder system. 
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A Shortcut for Experienced Operators 
When OptionFinder was first installed, a template of the example 
workshops in this Guide was installed along with it. If you have not built 
any meetings yet, the agenda for this template meeting is the first screen 
to appear in OptionFinder after installation. If the software has been used 
and another meeting appears, you may retrieve the template meeting 
from the Favorite Templates user folder, accessible from the user folders 
in the OptionFinder Database (see page 9 of this guide). 
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1. Overview of OptionFinder 
Just what is OptionFinder? You might call it an electronic meeting 
system, or a group decision support system, or "groupware." Some 
people think of it as an audience response system, or an interactive 
keypad system. In simplest terms, you could say OptionFinder is an 
electronic polling device. But these words only scratch the surface of 
what OptionFinder can do. 

At its simplest, OptionFinder is a combination of hand-held numeric 
keypads and computer software. It is a wireless electronic polling system 
used in meetings ranging in size from 5 to 2,000 people; each participant 
is given an OptionFinder keypad and can respond to polls presented on 
the "audience screen." With the OptionFinder software, the facilitator 
projects questions or statements onto an audience screen along with a 
set of responses from which the participants choose. Each participant 
pushes a number on his or her keypad corresponding to a response 
choice, and OptionFinder displays a graph of the response results. A 
graph may follow each question, or a whole set of graphs may follow a 
long series of questions, systematically analyzing opinion about 
something. 

A simple example of an OptionFinder event is measuring the comfort 
level of the participants. First, OptionFinder displays the following polling 
screen: 
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How comfortable are you with the direction 

that we are headed? 

1. Comfortable 
2. Uncomfortable 
3. … 
4. Very Uncomfortable 

51 
100 
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When polling is completed, the graph below appears:  

 How comfortable are you with the 
direction that we are headed? 

Pe
rc

en
t 

15%
30%

0%

65%

- 1 - - 2 - - 3 - - 4 -

 

How OptionFinder is Organized 

To understand how the OptionFinder is organized, you may find it helpful 
to think of the software program as a file cabinet containing several 
drawers. Within OptionFinder, a user folder is the equivalent of a file 
drawer and meeting folders are the equivalent of hanging files within 
those drawers. Meeting folders are "containers" holding the designs and 
data for OptionFinder meetings. Taken together, user and meeting 
folders make up the OptionFinder database. 

Folders 

Basically, user folders are just convenient places to store data for related 
meetings. They allow several users to share a system or one user to 
keep several styles (for example, a style specific to some foreign 
country, complete with native-language translations of all audience 
screens). 

Meeting folders are containers for all the exercises and polling data from 
a particular meeting, focus group, workshop, or other OptionFinder-
supported event. Meeting folders normally consist of an agenda and one 
or more exercise files. 
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Examples of User and Meeting Folders 

• User folder: Pat Patterson. Used to contain lots of meetings where Pat 
is the project leader. 

• User folder: Favorite Templates. Used to contain tried-and-true 
templates of exercise files, criteria scales, and the like. 

• Meeting folder: Strategy Session 1998. Used during the staff meeting 
to define our critical success factors for the 1998 calendar year. 
Includes OptionFinder exercises used to prioritize the factors and 
polling data collected. 

• Master meeting folder: Work Climate. Used to set up the employee 
workshops for our example workshops. In the master folder, you will 
define the exercises to be used in all sub-meetings. When polling data 
contained in the sub-meetings are consolidated into a single, inclusive 
data set, it is stored in the master folder. 

• Sub-meeting folder: Workshop folder used to actually run the exercises 
set up in the master meeting folder. The data for each sub-meeting (for 
example, Tokyo, London, San Francisco) is stored separately in its own 
sub-meeting folder.  

Naming User Folders 

If only one person is using the computer, then each of the user folders 
might be assigned names of the types of meetings being conducted or 
the client organization for which the meeting is being conducted. If more 
than one person is using the computer, then there will probably be a 
separate user folder for each person using the computer. 

Exercise Files 

OptionFinder exercises consist of a combination of polling questions, 
instructions for how the exercise is to behave when launched during a 
meeting, and polling data generated when the exercise is run in a live 
meeting. Several exercises are usually run to accomplish different 
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purposes in a single OptionFinder-supported meeting. For example, one 
exercise may be used as a "warm-up" to familiarize participants with the 
equipment. Another may be used to collect opinions on a particular 
issue, while a third may be used to prioritize a list of something. 

For example, to use OptionFinder to prioritize a team's list of "to do's," 
you would create a meeting folder with just one exercise design. The file 
for that exercise would contain the prioritizing exercise itself along with 
the polling data collected. It would be stored in the meeting folder, which, 
in turn, would be stored in the user folder. 

Other OptionFinder Components 

In addition to folders and exercises, OptionFinder includes the following 
major components: 

• OptionFinder database, in which you can create your user and meeting 
folders. The database dialog is also where you "manage" your folders 
(for example, back up, delete, compress, etc.). 

• Design tools, where you can design and customize polling exercises. 
The design tools include List Processing (for dealing with list of 
things), Questions (for asking multiple choice-type questions), Groups 
(enabling slicing and dicing data by subgroups of the audience), and a 
Participant Roster (if you don't want anonymous participants). 

• Agendas, where you can design and run almost any meeting from an 
audience-quality screen. Agendas are a special kind of OptionFinder 
tool; they serve to organize meeting events during the design phase, 
and as a "launch platform" for running OptionFinder events during the 
actual meeting. 

• OptionFinder desktop, where Windows "power users" can open lots of 
exercise files and windows, iconize them, tile them, etc. 

• Graphs, of data to show polling results to your audience. These graphs 
are generally simple presentations of the results, but you have the 
ability to show the data in several different ways via HotKeys. 
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• Reports, through which you can print reports of response data, or 
export results in spreadsheet-compatible format.  

OptionFinder Building Blocks 

It helps to think of OptionFinder as a set of exercises in which each 
accomplishes a certain outcome for your audience. If you use 
OptionFinder much, you will find yourself using the same methods 
repeatedly to accomplish similar outcomes; thus the software is designed 
around a system of templates to make it easy for you to reuse, instead of 
redesign. For example, you can save choices for questions (such as Yes 
/ No / Maybe) as templates, or you can save the whole question. Or you 
can template an entire exercise (for example, a tried-and-true series of 
questions to "warm up" your audience). Or you can save an entire 
meeting as a template.  

Similarly, when you design an OptionFinder-supported meeting, the 
activities consist of building blocks too. For example, your meeting may 
have three OptionFinder exercises in it. Each exercise consists of polling 
questions, response choices, and instructions for how the exercise is to 
behave. The exercises are organized into an agenda to make it easy to 
work with them both when you are designing and testing them, and when 
you are running them at Showtime. 

The OptionFinder Agenda 

By far, the easiest way to use OptionFinder is to organize the exercises 
and other design files you intend to use into an agenda, one of the 
primary OptionFinder tools. From an agenda you can easily: build 
exercise files, attach exercises to agenda topics from which they can be 
"launched" (that is, run the exercise according to the script specified in its 
behaviors), or display polling data from previously polled exercises. Most 
operators will set their systems to automatically load the last-used 
agenda in the last-used meeting folder when OptionFinder is first started. 

Try OptionFinder's help system. Find out more about how it starts up by 
pulling down /Help /Contents, then click the Index tab and type "startup 
preferences" and select "configuring startup preferences." This brings up 
the help topic regarding start up preferences. In addition to reading about 
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start up preferences, click the See also icon to learn more about related 
topics. 

First Steps for Setting Up a New Meeting 

This guide is organized around an example meeting, with a typical use of 
each of the tools. Each task you are instructed to do was selected to 
show you how to do something new or to rehearse needed skills.  

You do not have to go through the meeting exercises in the order they 
are presented here, but you do need to get the agenda set up first. 
Throughout the software, you can access the on-line help system. Either 
press <F1> for context sensitive help or pull down the Help menu and 
select the type of help you need. The steps you go through to set up a 
new OptionFinder meeting are straightforward: 

1. Select a user folder (or add a new one) to hold the meeting folder. 

2. Add a meeting folder to hold designs and polling data. 

3. Create an agenda to organize the exercises and to launch them at 
Showtime, when your audience is present. 

4. Add agenda topics laying out the activities and sequence of the 
meeting. 

5. For each agenda topic involving polling, create an exercise (design) 
file containing the questions and behaviors defining how the exercise 
will work.  
You will need to select which OptionFinder tool (Questions, Groups, 
or List Processing) is most appropriate for the exercise. 

6. Switch the source of incoming response data to simulate audience 
responses and test the designs to make sure they work the way you 
want them to.  
Then fine tune as necessary. 
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7. Switch to Showtime screen mode and rehearse the design the way 
your audience will see it, without the tool bars and menus of the 
Windows user interface. 

8. Purge the test data and test some more. 

9. Set up your keypad system, switch the source of data to keypads, and 
test the design in Showtime mode. 

10. If it is available, set up your computer projector system and test it too.  
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2. Creating a Sample Meeting 
Here's the situation: Your boss just volunteered you to prepare and run 
as part of an important HR initiative. He said, "We need you to put 
together a series of workshops where our employees tell us about their 
working environment. And we need it to start next week, eight four-hour 
workshops in different cities over a two - week period. Our deliverable is 
a written and presented report to the board at their meeting in three 
weeks in Singapore." 

Creating Folders and Agendas 

Before we can begin creating the actual exercises that will make up our 
meeting, we must first create a user folder and within it we will need a 
meeting folder to hold those exercises.  

Start OptionFinder 

If you have not already done so, start the software by pressing the 
Windows Start button and selecting Programs /OptionFinder 
/OptionFinder 5.  

Create a User Folder 

Your first task is to create a user folder to hold the meeting folders and 
exercise files you will generate as you go through this guide. Later you 
can delete this user folder if you wish without affecting any real meeting 
information. 

1. If it is not already showing, bring up the OptionFinder database 
dialog by selecting the File pulldown menu option Go to 
OptionFinder Database or by clicking the file cabinet icon. 
 

2. At the Select tab, add a user folder for your learning sessions by 
clicking the Add button for user folders. This produces the Add a new 
User folder dialog. 
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3. Give the new user folder a name, something like "My Learning," and 
click OK.  Your new user folder now appears on the list of user 
folders on the Select tab of the database dialog.  

Note: You may use a maximum of nineteen characters for the names of 
most items in OptionFinder.  

The following graphic shows the main tab of the database dialog where 
you select the meeting you want to open (or add a new one). It is 
available anywhere in OptionFinder by selecting the File pulldown menu 
option Go to OptionFinder Database.  
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Experimenting with the Online Help System 

In any OptionFinder dialog, you can get help by clicking on a control, pressing <F1>, 
or clicking the "What's This?" icon on the title bar (the question mark), then clicking 
on a control. (A control is any selection on a dialog that directs how OptionFinder will 
work. Examples of controls on this dialog are Add, More, Master, and Sub-meeting.) 
This is what is called "context-sensitive help" and it is available for every control on 
every dialog in OptionFinder. Use it to find out what a control does. 
 
Next click the Help button on the dialog and see what information it provides. This 
"button help" provides information about the function of the dialog as a whole, with 
links to the help for each of its controls. Some help screens have links to other 
related help topics. To access these links click on the title of the help screen.  

Create a Meeting Folder 

In this section, you will create a meeting folder to hold exercise files you 
will generate as you go through this guide. For this example, since you 
are creating a meeting model that will be replicated in several locations, 
you will create a "Master" meeting folder. It will contain all exercises to be 
used in each "sub-meeting" location; this way, you will create the 
exercises only once, then run the same exercises each time you conduct 
a sub-meeting. 

 

 

1. Make sure the user folder you want to work in is selected. 

2. Add a meeting folder for this learning session by clicking the Add 
button for meeting folders.  
 
This produces the Add a new Meeting to <user folder name> dialog. 
 
While you are looking at the Add a new meeting dialog, notice the 
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other ways you can add a new meeting folder to the system (Get a 
template, Restore a backup, or Copy an existing folder). 

3. Give the new meeting folder a name. 
 
For example, use something like "HR Initiative." 

4. Since this is to be a master meeting (for controlling several sub-
meetings), check the Master control. 
 
To create a regular meeting (one without sub-meetings), follow the 
same procedure, but do not check the Master control. 

5. Check the dialog for accuracy, and then click OK.  
 
Your new meeting folder now appears in the list of Meeting Folders on 
the Select tab of the database dialog. Since you added a Master 
meeting, OptionFinder has appended (Master) to the name you gave the 
meeting. 

Open the Meeting Folder You Want to Work In 

Next we will open the master meeting folder where you will create the 
OptionFinder exercises to be used in the workshops. 

1. Select the user and meeting folders we just created, click the Master 
control, and click OK. 
 
The confirm intention dialog "No agenda was created for this Meeting. 
Do you want to create one now?" appears. 

2. Click <Yes> to confirm your intention. 
 
Notice the user and meeting folders you are working in are always 
indicated on the status bar at the bottom of the screen.  
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Create an Agenda 

In this section you will create an agenda for the workshops. While doing 
so, you will also be instructed to try several features of OptionFinder to 
acquaint you generally with the interface. 

1. Open a meeting folder. 
 
When you open a meeting, the first screen you come to will depend on 
how your start-up preferences are set. For new meetings you will most 
likely come to a blank OptionFinder agenda. However, you could end 
up at the OptionFinder "desktop" (a blank looking screen with icons 
across the top). This is the main playground for Windows power users 
who are also expert OptionFinder designers, since they can open many 
windows, iconize them onto the workspace, tile the windows, etc. 
 
For most users the agenda is the main interface for using OptionFinder 
and you will rarely even see the desktop. Think of the agenda tool as a 
"home base." In fact, pressing the <Ctrl+Home> HotKey brings up 
your agenda. 

2. If an agenda is not the screen showing, click the Agenda icon on the 
tool bar (a big red "A") or press <Ctrl+Home> to open a blank 
agenda. 
 
If you have already created an agenda, it will be opened. 
 
Hint: If your agenda does not come up, make sure you are pressing 
<Ctrl+Home> and not <Ctrl+H>.  

Edit the Title of the Agenda 

Now you will want to give the agenda a meaningful title. This section will 
also help you become acquainted with what you have to do to edit 
anything in OptionFinder. 

1. Change the default title by double clicking the title area where 
"Agenda" appears (or press the <Ctrl+E> HotKey) and type “Work 
Climate Initiative”. 
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This produces a WYSIWYG ("what you see is what you get") editing 
screen where you can change the title. A good title for the audience to 
see is "Work Climate Initiative." 
 
This is a good place try OptionFinder's editor to see how it works and 
what its capabilities are. For example, you can change the font size or 
color of a word or phrase, and you can bold, underline, or italicize any 
of the characters. Be aware, though, that when you make changes in the 
font size or color, you are setting a specific parameter that will not be 
overridden if you later decide to make changes in the overall "meeting 
look and feel" of the audience screens for the meeting.  
 
As an example, let's say you decide to change the color of a word to 
red. Later you decide to change the background of the meeting screens 
to blue so that they all have white letters and blue backgrounds. Since 
the overall meeting look and feel does not override the individual 
changes that you have made in the editor, you will now have a red word 
on a blue background, making the word hard to read. We suggest that 
you use bold, underline, or italics to provide emphasis instead of color. 

2. Test the emphasis on the first word in your agenda title by 
highlighting the word and clicking on the "B," "I" or "U" icons.  
 
To remove the emphasis, highlight the word again and click on the 
same icon as before. 

3. Add the same emphases again, but this time use <Ctrl+B> HotKey to 
bold, <Ctrl+U> to underline, and <Ctrl+I> to italicize.  
 
We strongly suggest you learn the HotKeys for all functions you may 
need to use when your audience is watching. HotKeys allow you to 
perform editing and highlighting tasks more smoothly and rapidly than 
do the menus.  
 
If you want to add a second line to your agenda title, move your cursor 
to the end of the first line and press <Shift+Enter>. 
 
If you want to make the second line smaller than the first, highlight the 
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content of the second line, click on the font control and select the size 
of font that you want.  

4. When you have finished editing the agenda title, click the Save & 
Close Current Window icon on the tool bar or press the <F2> 
HotKey. 
 
The <F2> HotKey always saves and closes the current window. It is 
one you will use often. 

Create Some Text Variables 

Because this is a Master meeting that will control all the workshops, the 
city and date will have to change for each of the workshops. To make 
this easier, instead of changing the agenda title for each city and date, 
you will want to use OptionFinder's text variables to adapt the workshops 
more easily. 

1. Double click on the agenda title to edit it again. 

2. Move your cursor to the end of the first line and press <Shift+Enter> 
to enter a second line of text. Type @V3@. 

3. Press <Shift+Enter> again and on the third line, type @V2@. Press 
<Enter>. 
 
If you want to make the text on the second and third lines smaller than 
the text on first, highlight the content of both lines, click on the font 
control and select the size of font that you want. 

4. Select the Meeting pulldown menu option Variables /Define 
Variables to bring up the Variables dialog.  
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CancelOK Help  

When you installed OptionFinder, defaults for the first six variables were 
created. Variable @V3@ is the city name of the event and @V2@ is the date. 
Try the help for this dialog to learn more. 
 
Use the Meeting pulldown menu again and use your mouse or <Up arrow> or 
<Down arrow> keys to highlight different menu choices. Notice the short help 
on the prompt line at the bottom of the screen. It tells you generally what a menu 
selection does and what, if any, HotKey will do the same thing. 

5. Type in "London" for variable V3 and a date for variable V2. 

6. Click OK to close the dialog.  

7. Press <F2> to save changes to the Agenda title. 

Add Agenda Topics 

Now you need to create agenda topics for each of the workshop 
activities OptionFinder will be supporting. You are going to create the HR 
initiative workshops in which participants conduct a self-assessment of 
their company's work climate. The outcome you are after is an accurate 
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and in-depth assessment of what it is really like out there. Here are the 
agenda steps and polling exercises you will be going through, along with 
the OptionFinder polling tools that will do the job.  

Agenda Topic Tool 

Welcome & Introductions. 
 
This is where we will get to know each other a little and set expectations for the 
meeting. 

Agenda Topic 
Note  

Meeting Rules. 
 
This will be a "code of behavior" for the meeting. Participants can add rules they 
feel are necessary. 

List Processing 
tool, but no 
polling 

Introduction to the Keypads 
 
Create a "Warm up" exercise to break the ice, demystify the keypad system, and 
teach the audience how to use their keypads.

Question Tool  

Point of View 
 
Collect information from participants so OptionFinder knows what department 
they come from and the length of time they have been there. We want to use this 
data to find out how participants respond to other questions according to 
department membership and length of service. 

Groups Tool  

Introduction to Today's Process 
 
Ask a couple of questions about the organization's communication to get things 
rolling and to introduce the process. 

List Processing 
Tool 

Work Climate - Self-Assessment. 
 
Run through a list of statements about work climate, judging the statements on a 
scale of how well the statement describes their own experience in the company. 
Then run through the list again, this time asking whether things are getting better 
or worse around each statement in the list.

List Processing 
Tool 

Evaluation 
 
Evaluate the quality of the information collected in the meeting. 

Question Tool  

Test Keypads 
 
This is last because your audience won't be using it, but it is useful for making 
sure the keypads work properly (before the audience shows up).

Question Tool 
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Here's the agenda we will want to have when we are done.  

 

  

Welcome & Introductions 
 
Introduction to the Keypads 
Point of View 
Introduction to Today’s Process 
Work Climate – Self Assessment 
Evaluation 
Action Plan 
Test Keypads 

    Meeting Rules

Work Climate Initiative 
City  
Date

 

Let's get started! 

1. Add the first agenda topic by clicking the right-mouse button to bring 
up the short pop-up menu and then selecting New Agenda Topic.  
 
You can add a new agenda topic via a HotKey, but we want you to get 
into the habit of using the right mouse menu available in all audience 
screens. If you forget a HotKey when you are running live with an 
audience watching, the right-mouse pop-up menu will refresh your 
memory without forcing you to switch into Design mode. In fact, the 
right-mouse menu looks OK to an audience. (It looks like you know 
what you are doing, not that you forgot the HotKey.) 

2. At the Agenda Topic Editor type "Welcome & Introductions." Then 
click the Save and Close Current Window icon or press the <F2> 
HotKey to save it to the agenda.  

3. Using the same procedure (right click, select New Agenda Topic, type 
the topic name, and press <F2> to save the topic), add the rest of the 
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agenda topics. 
 
The topics you want to create are "Meeting Rules," "Introduction to the 
Keypads," "Point of View," "Introduction to Today's Process," "Work 
Climate - Self Assessment," "Evaluation," and "Test Keypads."  

Adjust the Look of the Audience Screens 

Now we will change what the audience actually sees on the screen. This 
is called "Look & Feel" in OptionFinder and you generally want to keep it 
as consistent as possible throughout your meeting. 

1. Switch to Showtime mode to display the agenda the way the audience 
will see it (<Ctrl+M> HotKey).  
 
This removes as much of the usual Windows interface as specified in 
the Define Showtime screen mode dialog. (You can bring up the dialog 
for defining Showtime mode via the <Ctrl+Shift+M> HotKey.) 
 
Press <Ctrl+M> to switch back to Design mode, and then again back to 
Showtime. 
 
Remember, your audience does not want to see all of the "noise" of the 
Windows interface. So, when you practice you should be in Showtime 
mode.  

2. Move a topic up or down on the agenda (<Ctrl+Up arrow> or 
<Ctrl+Down arrow> HotKeys). 

3. Change the size of the fonts for all topics on the agenda (<Alt+>> 
and <Alt+<> HotKeys). 
 
These HotKeys are always available to make adjustments at Showtime 
and are used often. Practice with them until you are familiar with how 
they work. 

4. Switch back to Design mode, then select the Meeting pulldown menu 
option Meeting Look & Feel.  
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The dialog for setting general look and feel parameters for the whole 
meeting appears. Here is one of the tabs for defining the look and feel 
for the audience screen. It is always available through the Meeting 
pulldown menu option Meeting Look & Feel. 

 

5. Change the color of the audience screens from "Blue on White" to 
"White on Blue." 
 
To do this, select "White on Blue" from the Available pallets list to 
change the overall color scheme for the meeting. 

6. Click OK to apply the new color scheme. 
 
OptionFinder installs with several good color palettes. If you want to 
create your own color scheme, go to the index of the help system and 
select "look & feel, configuring for meetings."  

Before you leave, notice the other things you can change: Font face, 
Counters and Timers showing during polling, and Sounds indicating 
progression during polling. 
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Give the Agenda File a Name 

In this section you are giving the agenda file you just created a name. In 
OptionFinder you do not have to name your files (they can remain 
"untitled"), but it is generally a good idea to name them anyway so you 
can understand what they are later. 

1. Select the File pulldown menu option Save As. to bring up the Save 
As dialog. 

2. Give the agenda the name "Work Climate" and click OK. 
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3. Creating Meeting Exercises 
In this chapter, you will be creating the OptionFinder exercises to support 
each of the agenda topics you created. 

Creating an Ice Breaker Exercise 

In this section you will create some icebreaker questions to get your 
meeting started and familiarize your audience with the OptionFinder 
system. 

1. Double click the "Introduction to the Keypads" agenda topic, and 
then click the New Tool button.  

2. Select Question Exercise and click OK.  
 
This brings up the pick list for questions.  

3. At the Questions Pick List, right click and select New Question, or 
click the New Question icon.  
 
The Question Type dialog appears. 
 
Use the "What's this?" icon (?) for definitions of Key Label and 
Maxkey. We are going to build icebreaker questions with a fixed set of 
responses.  
 
The Question Editor screen now appears and you can start typing the 
first question.  

4. Click the key label control and click OK. 

5. Type, "Did you ever lie to your mother?" and press <Enter>. 

6. Type the first response choice "Yes" and press <Enter>. 
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7. Create two more response choices. 
 
Use the following for this example: "No" and "Well, I wouldn't call it a 
lie exactly."  

8. Right click and select Label Graphs to go to the graph label editing 
screen.  
 
The first time you bring up this screen, OptionFinder feeds in the first 
few characters from each response choice below the bar representing 
that choice. You may edit these labels so they make sense to you.  

9. Press <Tab> and <Shift+Tab> to navigate between labels. 

10. Press <F2> to save and return to the Question Editor screen. 

11. Press <F2>, give the question the name "Mom", and click OK. 
 
OptionFinder will ask you for a name for any unnamed exercise each 
time you "Save & Close" (via <F2>, icon, or menus). You don't have to 
name exercise files, but it is a good idea and the bothersome Save As 
dialog quits popping up. 
 
When you are attaching exercises to agenda topics previously created, 
OptionFinder has some "housekeeping" to do and may ask you some 
questions to clarify your intentions. 

12. Repeat these steps to create another question. 
 
For this example, use the stem "Have you ever driven more than 30 
m.p.h. over the speed limit?" and with "Yes" and "No" as the response 
choices. Make sure you label your graphs. 

13. Press <F2> to save and give the question a name: "Speeding." Click 
OK. 

14. Press <F2> again and give the entire question exercise a name: 
"Icebreaker." 
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15. Click OK. 
 
You should now be back at your agenda.  

Test the Exercise 

In this section, you will simulate polling the exercise you just added to 
your meeting to make sure it works properly. You don't need to set up 
the keypads for testing. If your test works via simulations (either 
computer generated or through the keyboard), and then later your 
keypad system works generally, you don't actually have to test the 
keypads for each individual exercise. 

1. Change the Source of Data to Simulate by pulling down the Meeting 
menu and selecting Source of Data /Simulate. 
 
Notice that "Simulate" shows on the right side of the status line at the 
bottom of the screen. 

2. Switch to Showtime mode (<Ctrl+M>) so things will appear as your 
audience will see them. 

3. Highlight the agenda topic "Introduction to the keypads," then press 
the <F10> HotKey to launch the warm-up exercise.  
 
A confirm intention dialog "You are about to commence polling in the 
master meeting" will pop up. Since we are only testing our exercises 
and not entering valid data, click <Yes>. 

4. Take a close look at the question itself to make sure it is what you 
want to present.  
 
You can ignore the colors, font face, response graphic, and counter for 
now since meeting-wide look and feel parameters like these can be 
changed all at once. However, you should be thinking about how you 
would like the polling screen to appear. 

5. Generate some data through one of the following methods. 
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• Press <R> to generate random responses. 
 
This will immediately bring up a frequency distribution 
graph of the data, since the system defaults for sequence 
behaviors are set to show graphs after each question. 

• Press <L> to generate responses skewed to the low end of 
the scale. 

• Press <H> to skew to the high end. 

• Press <S> to split between highs and lows. Be sure to 
give some factors high and some low marks.  

Here are some things to think about as you look at your data: Is the 
question really what you want to ask? How will you facilitate once the 
graphs are up? Are the graphs what you want and did they appear when 
you wanted? This kind of mental rehearsal as you are creating and 
testing exercises improves the exercise and prepares you for the live 
meeting. 

6. Press the <F10> HotKey successively to continue the sequence. 
 
Once the exercise has run to completion (in this case, finished its two 
questions), pressing <F10> again returns you to the agenda. Observe 
how the <F10> HotKey works. At the agenda, it launches the exercise, 
goes to the next scripted event in the exercise, and when there are no 
more events in the exercise it returns to the agenda.  

Note the sequence you just went through: 

1. Create an agenda topic.  
2. Create a design to support it.  
3. Return to the agenda, and launch it to ensure it is working properly.  
4. Mentally rehearse facilitating your audience through the exercise.  

This is a sure-fire method for creating exercises that work the way you 
want them to. If you find something not quite right, fix it and run the test 
again. 
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Purge Polling Data 

You should now erase the test polling data so you can test again. 

1. Switch to Design mode. 

2. Purge the test data from the icebreaker exercise by highlighting the 
agenda topic, then selecting the File pulldown menu option Purge 
Data/Purge Current Topic Data. 
 
OptionFinder will give you warnings before purging the data. You 
should get in the habit of reading these warnings if any real data has 
been collected in the meeting so you don't inadvertently purge 
important data. 
 
Caution: You cannot recover purged data. Never purge data collected 
from a real audience unless you have backed it up first.  

Where Response Data is Stored and When to Purge It 

As soon as the last response is given to a particular question and 
OptionFinder has advanced to the next event, the response data is 
automatically saved to your computer's disk drive. You do not have to 
manually save response data. The data is stored with the design file 
holding the particular OptionFinder exercise you just ran. 

If you do not purge test data and decide to run the same exercise again, 
OptionFinder will produce a dialog where you are asked what to do with 
the existing response data. If you get this dialog by mistake, pressing 
<Esc> or the Cancel button will take you back with no harm done. If the 
data is test data, choose "Purge and Replace." OptionFinder will give you 
a warning that you are about to destroy data and ask you to confirm that 
you want to proceed with the purge. Answer "yes" and OptionFinder will 
purge the response data and bring up the first polling screen in the 
exercise.  
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 Caution – Polling Data Exists…

 

This dialog automatically appears if you try to poll an exercise that has 
already been run. If one or more questions in the exercise have not been 
polled, another choice will be available: "Fills holes in series." 

Purge Data from a Single Polling Exercise 

These are the steps to take if you want to purge data from a polling 
exercise before you run it again. 

1. Highlight the agenda topic from which you want to purge data. 

2. Select the File pulldown menu option Purge Data /Purge current 
topic data. 
 
This will delete the polling data in the exercise linked to this agenda 
topic, not the exercise itself. 

3. Follow the dialogs, paying attention to the warnings. 
 
Read the warning messages carefully to make sure you have the correct 
file highlighted. When you have more than one design file, it is easy to 
highlight the wrong one and start the purge procedure. Always double 
check the file name before you answer, "Yes" to the warning messages!  
OptionFinder will give you at least two warnings before purging.  
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Purge Data from the Whole Agenda 

These are the steps to take if you want to purge data from all exercises 
attached to the agenda. 

1. On the File menu, point to Purge Data, and click Purge all Poll data 
(This Agenda). Or click on the Purge Current Agenda icon. 

2. Follow the dialogs, paying close attention to the warnings.  

Practice Functions Available When Polling is Underway 

There are several important functions available while polling is 
underway.  

1. From the Meeting menu, change the Source of Data to your computer's 
keyboard. 
 

2. Launch the "Ice Breaker" exercise again. 
 

3. Use the number keys on your keyboard to enter response data from 
10 participants. 

4. Complete each of the functions described in the following sections.  

 

Interrupt the Polling Sequence 

Many times, the unexpected happens and you need to stop the polling 
sequence in order to do something else. If you do stop an exercise 
series without completing it, you can start it again where you left off.  

1. While polling is underway, press the <Esc> HotKey.  
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This dialog appears when you press <Esc> when polling is 
underway. OptionFinder will always require you to confirm your 
intention to stop in the middle of polling an exercise. 
 
Try interrupting the sequence via the <Ctrl+Home> HotKey to 
take you back to the agenda before completing the exercise. 

2. At the confirm intention dialog, keep the selection set to "Exit polling 
sequence" and check the box to Keep data for this poll.  
 
Now you have completed the first question, but not the second. 

3. Launch the exercise again and follow the prompts to continue this 
question series. 
 
Use help on the dialogs if you need to.  
 

4. Purge test polling data. 

Reset Responses for the Current Question 

Quite often you will want to zero out responses to a poll and reset the 
timer. Even though the next response from a participant replaces an 
earlier one, it seems to give audiences comfort to see things reset and 
starting over. 

1. Launch the “Icebreaker” exercise again. 
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2. Key in some responses to the first question. 

3. Press <Delete> to zero out the responses so far and begin polling 
again.  

Before moving on, spend some time looking at the menus to see what 
you can do during polling. Remember that many functions are available 
by clicking the right-mouse button.  

4. Enter a few responses for this question and press <F10>.  

Reduce the Number of Keypads OptionFinder Looks For 

During polling, OptionFinder looks for the number of keypads defined in 
the Define Keypad System dialog (Meeting/Keypads /Define Keypads). 
For example, you may think 20 participants are attending, so you define 
the keypads you will be using as addresses 1-20. At Showtime, you find 
only 15 people showed up, so you will want to reduce the keypads to the 
15 they are using. 

1. Key in 15 responses on the next question. 

2. Press the <-> (minus) HotKey to tell OptionFinder to only look for 
these 15 keypads (participants) that have responded.  
 
On the next question you ask (even in a new exercise), only responses 
from these 15 keypads will be expected. 
 
Of course, as soon as you do this, the 16th person shows up. To reverse 
the process and look for all keypads again, just press the <+> (plus) 
HotKey during polling. Press <-> (minus) again when all 16 responses 
have been entered. 

Hide the Screen Temporarily 

You will encounter times when you want to temporarily blank out the 
audience screen, such as when audience members are talking. 
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1. Press the <Ctrl+H> HotKey to hide the audience screen. 

2. Press any key to show it again.  

3. Return to your agenda. 

Creating Demographic Categories for "Slicing" Response 
Data 

You want to keep track of data broken down by participants' departments 
and how long they have been with the company, so you will use the 
Groups tool. The procedure for creating grouping questions is identical to 
the procedure for creating questions in the Questions tool.  

1. Double click the "Point of view" agenda topic and then click the New 
Tool button. 

2. Select the Groups file and click OK.  
 
This brings up the Groups Pick List. 

3. Right click and select New Group. 

4. Select the Mutually Exclusive grouping logic method to add a 
grouping dimension. Click OK. 
 
This brings up an editing screen where you create the subgroups from 
which the participants will make their choice. 

5. Change the default question stem to "What is your department?" 
Then press <Enter> to bring the cursor to the choices area of the 
screen. 
 
Try the <Ctrl+Del> HotKey as a quick way to delete the default 
question stem. This HotKey deletes everything in the current 
component of any editor screen. Sometimes it deletes more than you 
think, so be careful. 
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6. Type in the first subgroup "Sales & Marketing" and press <Enter>. 

7. Create three more subgroup categories: "R&D," "Manufacturing," 
and "Support Administration." 

8. Press <Tab> to move to the bottom portion of the screen and type in 
an orienting prompt: "Your department is where your paycheck 
comes from." 

9. Right click and select Label Graphs or press the <Ctrl+L> HotKey to 
go to the graph label editing screen.  
 
Edit these labels so they make sense to you. 

10. Press <F2> to save the graph labels. 

11. Press <F2> and give the grouping dimension a name: "Department." 
Click OK. 
 
This label will be used to identify what subgroup's data is being 
displayed in the graphs, so your audience will see it. 

12. Create a second grouping dimension to determine how long they have 
been with the company. 
 
Use the following subgroups: "Less than 2 years," "2-5 years," "6-10 
years," and "More than 10 years." 

13. Edit and save the graph labels. 

14. Press <F2> and name the grouping dimension something like 
"Tenure with the company." 
 
Remember, it will show up on the graphs at Showtime. 

15. At the Groups Pick List, press <F2> to save the whole grouping 
exercise, and then name the exercise. 
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We typically name the group design file "All Groups" or "Groups" into 
which we place ALL of the grouping dimensions. You cannot have 
more than one group exercise file in your meeting. 
 
Press <F2> to return to the agenda. 

16. Launch the exercise and enter some response data.  
 
After you have collected data for both questions, navigate between the 
graphs in the design file either by pressing the <left arrow> or <right 
arrow> keys or by pressing the <letter> key which corresponds with the 
item you wish to view. (For example, the first item polled will be A, 
the second item will be B, etc.) 
 
Notice the results are defaulting to percentages in each group. Toggle 
back and forth between percents and counts via the <F7> HotKey. 

17. Return to the agenda.  

Creating a List Processing Exercise to Get Things Rolling 

Since every survey comes up with communications as a hot issue, you 
are going to use it to introduce your main process. So you need to create 
a couple of questions about communication. 

1. Double click the "Introduction to Today's Process" agenda topic, and 
then click the New Tool button to create a new exercise. 

2. Choose the List Processing Exercise and click OK to get to The List. 

3. Press <Insert> and enter the first "item" in the list: "I understand 
our company strategy."  

4. Press <Enter> or <F2> to save the first list item. 

5. Enter a second item: "I see a clear relationship between my 
department's priorities and our company strategy." Press <Enter>. 
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Notice the list items are normally identified with letters. The reasoning 
behind the default of identifying items in the list by letters is to allow 
more HotKeys to navigate among the graphs. For example, you can 
navigate through a list of 26 items simply by pressing the 
corresponding letter from A to Z. 
 
The purpose of allowing numbers is that sometimes an agenda or list is 
submitted to the OptionFinder operator already created with numbers 
or, as in this case, a list is being created without the need for identifiers 
at all. If you do use the numbers on a list that will be polled, you will 
need to make your own "key" map telling which number equals which 
letter (for example, "1" = A; "10" = J; and "18" = R) so that you can 
navigate quickly in front of the group using the letter keys. 
 
If you wish to change the way items are identified right click 
Behaviors/The List Behaviors or click the List Behaviors icon and 
change the Item identification style to "Numbers." 

6. Right click and select Go to Criteria Pick List to switch to the screen 
from which you can create the criteria your audience will use to 
judge these statements. Using the same general steps you used to 
create your grouping dimensions, create two criteria. 

7. Select Key Label at the Criterion Method dialog box. 
 
Use "What's This?" help to see what the other choices are. 

8. For the first criterion, create some choices: 
1. This is not us at all.  
2. This fits us some of the time.  
3. This fits most of the time.  
4. This describes us quite well.  

 
9. Add an orienting prompt "In your experience, how well does this 

statement describe us?" 

10. Create your graph labels and give the criterion a name such as "Our 
Performance." 
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11. Create a second criterion with these choices:  
1. We are actually getting worse.  
2. We are staying about the same.  
3. We are improving."  

 
12. Add an orienting prompt “Over the past year how have we changed?” 

13. Create your graph labels and name the criterion “Direction.” 

14. Save and name the exercise "communication." Return to the agenda. 

15. Launch the exercise and enter response data for all questions. 
Observe the way the exercise behaves, noting anything you want to 
change. 
  

Navigate the Graph 

So far you have just been bringing up the graphs in a simple way. 
However, you should think of everything you do in order to show graphs 
of polling data to your participants. It is the graphs themselves that 
stimulate discussion and you will need to switch to the most effective 
view of the data to accomplish the best possible discussion. In this 
section, you will use the menus and HotKeys to navigate among the 
many graph views. You should plan on mastering OptionFinder’s 
HotKeys for these functions because your audience will always be 
looking on as you bring up the best view. 

1. Bring up the graphs by highlighting the agenda topic and pressing 
<F9>.  
 
Since you have data for two criteria, you can display responses to each 
one individually or to both together. 
 
For help on what a graph means and what you can do there, press 
<Shift+F1>. The Help HotKey is <Shift+F1> in the graphs since the 
<F1> HotKey is used to bring up a particular view of the data (as do 
<F2>, <F3>, and <F4>). 
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2. Right click and select Change Criteria View/Horizontal Axis to pull 
up the F1 Averages graph for the Communication criterion.  

3. Press <item letter> keys (A or B) to focus in on responses to that item. 
 
It takes a little time and practice to move fluidly among the graph 
types. However, in most exercises you will only need to know a few 
HotKeys since you never want to show your audience all the views.  
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Slice the Data by Subgroup 

In this section, you will be displaying polling data to highlight differences 
(or similarities) among the subgroups in your audience. There are two 
ways to display subgroup information:  

• Show the data for just one subgroup.  
• Show averages for all subgroups to illustrate similarities or differences.  

The following instructions show how to do the latter: 

1. From the Averages graph, press the <Ctrl+G> HotKey to bring up the 
Group Behaviors dialog. 

2. Highlight either "Tenure with company" or "Department" and click 
OK. 
 
Notice the title for the group dimension you selected now appears on 
the right vertical axis of your graph. 

3. Press the <F4> HotKey to bring up the subgroup comparisons. 
 
The bar for “All” represents the average response for the entire 
audience. The remaining bars represent the average response for 
participants in the corresponding subgroups.  

4. Press <F1> to return to the overall averages graph. 

5. Press the <1>, <2>, <3>, and <4> keys to view a single subgroup’s 
average response to all items on this graph. (Note the label on the 
right vertical axis changes as you switch subgroup views.) Press <0> 
to get back to everybody. Press <Ctrl+G> to change to the other 
grouping dimension. 

6. Test these views for a while until you see how the <Letter>, 
<Number> and <F1>, <F2>, <F3>, & <F4> HotKeys work to 
smoothly navigate among complex data.  
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Adjust the Behaviors for the List Processing Exercise 

Behaviors are the controls that determine how and when the questions 
should be asked, how and when the responses to questions should be 
displayed, and what the overall look and feel for your exercise (meeting) 
will be. 

If the default template has not been changed since OptionFinder was 
installed, you are seeing the most commonly used behavior settings, 
since you didn't change any behaviors when you created the exercise. 
Notice that all the exercises you created behaved close to the way you 
wanted them to without your having to adjust anything. However, for 
purposes of furthering your OptionFinder education, you will make some 
changes anyway. 

1. From the Agenda, highlight the "Introduction to Today's Process" 
agenda topic, right click and select Go to Linked Exercise to get to the 
Criteria Pick List screen. 
 
Remember the poor title on the main graph, "Averages Response to All 
Polls?" We will be changing that next. 

2. Right click and select behaviors/graph behaviors. Click the graph 
titles tab of the dialog. 

3. Click the box telling OptionFinder this label is to take precedence 
over meeting audience screen labels. 

4. Change the title to something a bit better like "Work Climate - 
strengths & weaknesses." Click OK 

5. Bring up the sequence behaviors dialog.  
 
Suppose you want to ask the participants both criteria questions before 
moving on to the next list item, which means you want to rotate criteria 
before rotating the workplace factors. 

6. Set the Rotate all... control to "criteria, then items." 
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Look at "What's this?" help on the sequence controls for: Show graphs 
after, Polling Sequence, and Rotate All. 

7. Save these changes and test the exercise design again, observing the 
effects of your changes. 

8. Change the rotation behavior back to "items, then criteria," then 
return to the agenda when you finish.  

Save the Criteria as Templates 

The criteria you developed and fine-tuned for our "Introduction to Today's 
Process" exercises are the same ones you will be using in our "Work 
Climate" exercise. Instead of retyping these criteria in the next exercise, 
we're going to save them as templates and use them again. However, 
just so you don't clutter up our "Favorite Templates" folder with 
something you won't be using much, these instructions have you save 
the criteria as templates into your Learning folder. 

1. Select the agenda topic "Introduction to Today's Process" and go to 
the linked exercise.  
 
The Criteria Pick List appears. 

2. Select the first criterion and select the Edit pulldown menu option 
Save Criterion as Template.  
 
The Save Template dialog appears. 

3. Give the criterion template a name or use the name it already has, 
then click OK. 

4. Select the second criterion and press HotKey <Ctrl+Shift+T> to make 
a template of it. Return to the agenda. 

You use these same steps to template questions and grouping 
dimensions. The <Ctrl+T> HotKey brings up the dialog for loading 
templates and the <Ctrl+Shift+T> HotKey brings up the dialog for saving 
a template. 
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Save the Process Behaviors as a Template 

Again, to save energy you should template the behavior settings for the 
process you have tested.  

1. At the Criteria Pick List, right click, select Behaviors /Sequence 
Behaviors.  
 
The Sequence Behaviors dialog appears. 

2. Click the Template button. 
 
The Behavior Templates dialog appears. 

3. Click the Save tab, and give the template a name ("Self assessment"). 

4. Save all behavior sets and save them to the location just for this 
meeting. Click OK. Return to the criteria pick list. 
 
This saves all behavior dialogs associated with this exercise as the 
template. You could have just saved the settings on the Sequence 
dialog if you wanted to. 
 
It also saves the template for access from just this meeting. If you do 
find the behaviors generally useful, you should save them in a user 
folder accessible to other meetings (for example, your "Favorite 
Templates" folder). 
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Save the Whole Exercise as a Template 

By now you probably realize it would have been more efficient to save 
the whole exercise as a template, then just replace the list items with 
those of the "Work Climate" exercise. Here is how: 

1. At the Criteria Pick List, or at the List itself, select the File pulldown 
menu option Save Exercise as Template. 

2. Give the template a name and specify a location in which to store it. 

3. Return to the agenda.  

Creating a Self-Assessment Exercise by Modifying a 
Template 

This exercise has six self-assessment statements about work climate, 
and two criteria for judging them (the same two criteria you asked in our 
Introduction-to-the-process exercise). Here is how to set it up by using 
the exercise template you saved before. 

1. Double click on the "Work Climate" agenda topic, and then click the 
Template button. 
 
The dialog for loading exercise templates appears. 

2. Select the user folder in which you stored the example process 
template and from the “List template for:” control select the List 
Processing Exercise. Your template name should appear in the “Load 
as name” box. 
 
Rename the template "Work Climate" and click OK. 

3. Bring up The List via the <F11> HotKey, and then delete the two 
statements used in the example. 

4. Add these statements to the list:  
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A. The performance appraisal process is fair and constructive. 
B. People know what is expected of them and why. 
C. Communication flows freely and honestly in all directions. 
D. Trust levels between associates and management are high. 
E. The right people get promoted. 
F. Everyone feels involved in making the company better. 

5. Change the title from "List Items" to "Factors affecting our 
workplace." 
 
Use the same methods you just learned for changing an agenda title. 

6. Right click and select Go to Criteria Pick List.  
 
This is just to verify the criteria that were loaded along with the 
template. 

7. Click the “Save and Close Current Window” icon, or press <F2>, 
twice to return to the agenda. 

8. Make sure your data source is set to Simulate. 

9. Highlight and launch the exercise. 
 
The list appears first. 

10. Press <F10> again to begin polling.  
 
As the polls are presented, observe how they behave exactly as they did 
in our example process because you merely used a template of it. 

Navigate Two-Criterion Graphs 

In this section you will begin to use the HotKeys to explore the data 
collected during the poll. As you do so, notice how each change in the 
view could be useful for generating discussion about some aspect of the 
data. 
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1. Go to the graph view you want to work from. 
 
If the default graph behaviors have not been changed, the graph that 
appears after polling is complete should have two axes with direction as 
the criteria defining the horizontal axis and performance defining the 
vertical axis.  

• If a two-axis graph does not appear, right click and select 
Change Criteria View, then select Both Axes. 

• If you need to change the criteria, right click and select 
Change Data/Criteria and define the criteria for both axes. 

• If you are not at an overall averages graph, press <F1> to 
bring one up.  

This is often called the "anchor" graph because it shows data for all list 
items. 
 
The upper right quadrant shows factors whose ratings say, "Describes 
us well and still improving." The lower right means, "Does not describe 
us, but is getting better." The lower left means, "Does not describe us 
and is getting worse." And the upper left means "Describes us, but we 
are losing it." 

2. Take a closer look at an interesting rating by "zooming" in it 
(pressing the corresponding <item letter> key). 
 
The first press of the <item letter> shows the list item in the title area of 
the graph. If you press a different <item letter>, its text shows in the 
title areas. However, if you press the same <item letter> twice, it 
"zooms in" on that item. 
 
In a two-criterion graph, this produces a scatter plot showing a data 
point for each person who responded to both criteria. That is, each 
diamond is a person's score on both criteria. The item letter is plotted at 
the average for everybody who responded. 
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3. Split the two-axis graph into each of its components. 

• Press <Ctrl+F2> to show a single axis plot of the data for 
the criterion plotted on the vertical axis. 

• Press <Ctrl+F3> to show just the horizontal axis data. 

• Press <Ctrl+F1> to show both again.  

Navigate One-Criterion Graphs 

In this section, you are navigating among graphs of data for just one 
criterion. The same methods work for navigating among questions in the 
Questions tool. 

1. Switch to the "overall average" or "anchor" graph (<F1> HotKey). 

2. Press <Ctrl+F2> to bring up a one-axis graph.  

 Now let's interpret the graph. Suppose your facilitation process is to 
celebrate the best, then focus in and talk about the worst workplace 
factors. 

• Sort the workplace factors (list items), based on average 
response, from highest to lowest score via the <F7> 
HotKey. 

• "Zoom in" on the factor with the highest score by 
pressing the <letter key> identifying it twice. 
 
You just zoomed in on the factor with the highest score 
by bringing up the frequency distribution for it, showing 
the percentage of the audience responding to each choice. 

• Go to the next best (next highest average) by pressing 
<right arrow>. 
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• Now press <End> to jump to the worst rating, then press 
<Left arrow> to go to the second worst rating. 
 
The <left arrow> and <right arrow> keys walk through 
the list items in the order they appear on the <F1> graph. 

3. Press <F3> to bring up a graph illustrating the relative diversity in 
the data. 
 
These too can be sorted if you want to walk through the data in order of 
diversity. 

4. To show results for the other criterion, press <Ctrl+F3>.  

 

Trim the List of Work Climate Statements 

This exercise introduces you to the List Trimming feature. List trimming is 
useful when you want to go through more than one evaluation process to 
reduce your list.  

In this scenario, let's assume we have enough resources to make 
significant improvements over the next 6 months on our performance in 
only one of the areas listed above. We now need to take the items that 
scored poorly on this criterion and determine which we should focus on 
first.  

1. From your agenda, right mouse click to bring up the pop-up menu. 
Select New Agenda Topic. 

2. Type "Action Plan," and click New Tool, then select the List 
Processing Exercise. 

3. Right click and select Go to Criteria Pick List. 

4. Press <Insert>, then at the Criterion Method dialog, select Paired 
comparison and click OK. 



_________________________________________ 

OptionFinder® Version 5 Start-Up Guide Page  
www.optiontechnologies.com 

53

5. Type, "Which item should we focus on first?" and click the Save and 
Close Current Window icon or press <F2>. 

6. Name the criteria "focus," and click OK. 

7. Press <F2> twice, give the exercise a name such as "action," and 
click OK. 

8. Highlight the "Work Climate" agenda topic, right click, select Purge 
current topic data, and purge all polling data. 

9. Launch the "Work Climate" exercise again. This time instead of 
pressing <R> to generate simulated data, press <L> on three of the 
items and <H> on the others. 
 
If you press <R> to generate data the resulting graphs are usually flat. 
This time, we want a significant difference in the average score for the 
list items, so we need to skew some of the data high and some low. 
 
You should now have some data collected. 

10. Bring up a one-axis averages graph for the performance criteria, and 
then press <F7> until the data is displayed from low to high.  
 
Hint: If you can't remember how to bring up the different graph views, 
press <Shift+F1> to bring up the context-sensitive help. 

11. Right click to bring up the pop-up menu. Select Edit/trim the list. 

12. Use your <right arrow> or <left arrow> key to move the arrow that 
now appears on your graph. 
 
Move the arrow until it is over the last item that has a score of 2.5 or 
lower. 

13. Right click to bring up your menu again, select Edit/Save the trimmed 
list. Click Yes.  
 
The Trim the List dialog appears. 
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14. Click the control for another file, select the file named "Action," and 
click OK. 

15. Press <F10> to return to your agenda. Highlight and launch the 
"Action Plan" exercise. Return to the Agenda. 

Creating a "Slide" to Help with Introductions 

For the first agenda topic, you will be using OptionFinder’s "Topic Note" 
function to provide a little support for the introduction process. It really 
isn't an "exercise," but it can be quite useful. 

1. Select the agenda topic "Welcome and Introductions." 

2. Use the right-mouse click to pop up a short menu of the functions 
available here and select the Agenda topic note to bring up the editing 
screen. 
 
Notice the HotKey reminder on the pop-up menu. 

3. Type in the following text: 
 
Please... 
Tell us your name and department. 
Tell us why you think you are here. 
Remember, (Shift+Enter> moves you to the next line of text. 

4. Press the <F2> HotKey to save the note. 

5. Test it by switching to Showtime mode, and then bring up the note 
with the <Ctrl+Shift+N> HotKey. Press <Esc> to return to the 
agenda. 

6. Switch to Design mode. 
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Creating a List of Meeting Rules 

In this section, you will use the list processing tool to present a list of 
rules governing the meeting. You will create a design file for the meeting 
rules and attach it to the agenda topic. 

1. Double click on the "Meeting Rules" agenda topic (or press the 
<Enter> HotKey) to bring up the editor, and then click the New Tool 
button. This brings up the New What? Dialog box. 

2. Select the List Processing Exercise (since you are going to create a 
list of rules) and click OK. 

3. Change the title of the list from "List Items" to "Rules for Today's 
Meeting."  

4. Add the following rules to the list: “Everyone gets to participate,” 
“No personal attacks allowed,” “Stay on task,” and “No whining.” 

5. To get rid of the letters by the rules right click and select Behaviors 
/The List Behaviors to bring up the List item Behaviors dialog. 

6. From the Display tab, go to the Item identification style control, select 
"None," then click OK to close the dialog. 

7. Since there isn't any polling involved with this list, set the sequence 
behavior for the list to run as a list only. 
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8. When you are finished with your list of rules, click the Save and 
Close Current Window icon.  

9. Give the exercise a name ("Meeting Rules") and click OK. 

10. Test the exercise. 

11. Toggle between Showtime and Design Screen modes, move some 
rules around, and change the font size for all the rules by using 
HotKeys. 
 
If you can't remember the HotKeys, try the menus and right mouse 
click menu to refresh your memory.  

Creating a Meeting Evaluation  

In this section, you are using the Questions tool to create the final 
exercise for the meeting.  
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1. Double click the "Evaluate" agenda topic. 

2. Via New Tool, select the Questions tool and click OK. 

3. Create three questions of your own that address the following items 
(use Key Labels): 

• Does your audience think their data (polling results and 
discussion) pretty well reflects reality? That is, did you 
get an accurate picture? 

• Did they like the process you used? 

• Do they have any suggestions for improving the process?  

Creating an Exercise for Testing Keypads 

In this section, you are creating an exercise just for testing the keypads. 
Your audience won't be using it, but it is good for making sure everything 
works correctly. 

1. Double click the "Test Keypads" agenda topic. 

2. Via New Tool, select keypad test and click OK. 

3. Return to the agenda. 

Using the Master Design in a Sub-Meeting 

You have spent all of your time so far designing your meeting process 
model in the meeting Master. In this section, you will open a sub-meeting 
to test your design in one of the sub-meetings. 

Create Some Sub-Meeting Folders 

In this section, you are creating folders to hold the data generated in 
each of the workshops. 
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1. From the File pulldown menu, select Go to OptionFinder database. 

2. Make sure the User folder "My Learning" and the Master meeting 
folder "HR Initiative (Master)" are selected. 

3. Click the Sub-meeting control in the Meeting folders group.  
 
The sub-meeting controls are enabled. 

4. Add a sub-meeting folder for your first workshop by clicking the Add 
button for Sub-meetings folders. 
 
The Add a new Sub-meeting folder dialog appears. 

5. Give the new sub-meeting folder a name for the first workshop (for 
example, London). 

6. Check the dialog for accuracy, and then click OK. 
 
Your new folder now appears in the list of Sub-meeting folders. 

7. Add two more sub-meeting folders to hold the data from your 
workshops in New York and Tokyo. 

8. Click OK.  

Open a Sub-Meeting 

In this section, you are opening one of the sub-meetings instead of the 
meeting Master. The designs you created in the Master will control the 
events in the sub-meeting, but the polling data will be stored in the sub-
meeting folder. 

1. From the File pulldown menu, select Go to OptionFinder database to 
bring up the dialog for opening meetings. 

2. Select the London sub-meeting. 
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Notice the sub-meeting opens and looks just like the meeting master 
agenda. However, the status line shows London as the meeting you are 
working in now.  

Adjust the Sub-Meeting to Match the Workshop 

You will need to change the keypad universe for the keypads you will be 
using and change the variables for city and date.  

Hint: Use the Meeting pull down menu. 

Set the Keypad Universe 

You need to tell OptionFinder how big your meeting is (the number of 
keypads that will be used in your meeting). 

1. From the Meeting pulldown menu, select Keypads/Define Keypads 
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This is the dialog for defining the keypad system you will be using for the 
meeting. It is important to set the "keypad universe" to the maximum 
number of participants that may attend. 
 
Read the help for this dialog to better understand the relationship between 
keypad addresses and participants. 

2. Make sure that the lowest keypad address and highest keypad address 
create a range that includes the keypads you are using. 
 
For this example, assume you will be using keypads addressed 1-20. 

3. Since all your workshops will have less than 20 participants, check 
the control to save settings as the default for future meetings. 
 
This way you won't have to adjust the keypad universe each time. 
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4. Click OK to continue.  

Change the Variables to the Needs of the Sub-Meeting 

For each sub-meeting the city and date will be different. Here is how to 
adjust them: 

1. From the Meeting pulldown menu, select Variables /Define 
Variables. 

2. Enter the text for City and Date in the appropriate fields.  

Test the Sub-Meeting 

In this section, you are testing one of the sub-meetings just to make sure 
the designs from the Master Meeting are working properly. 

1. Run through a test of the design just as you did in the meeting 
master. 

2. Observe how everything behaves the same way.  

Test a Different Sub-Meeting 

In order to take you through a data consolidation process, you will need 
to have data for two or more workshops. Here you are just simulating 
another workshop so you can consolidate their data. 

1. Open a different sub-meeting. 

2. Simulate polling data for each of the polling exercises.  

Consolidate the Data from the Sub-Meetings 

In this section, you will consolidate the data from your workshops into a 
single data structure. The consolidated total will be placed in the master 
meeting folder. 
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1. From the OptionFinder database, select the Master meeting tab, click 
Consolidate, and then click Apply. 

2. Click the Consolidation Behaviors tab and exclude all participants 
who never responded. 
 

                       
 
This is the dialog for consolidating data from the sub-meetings. You 
can choose some or all of the sub-meetings to include in the 
consolidation. 
 
The other tabs of this dialog control what data is included or what 
reports you want about what happened during consolidation.  

3. Return to the Select Sub-meetings tab and select the workshops you 
want to include in the consolidation, then click OK. 

4. From the Select tab on the database, select your master meeting 
again and click OK. 

From the agenda, highlight the "Introduction to the Keypads" topic, and then 
press <F9> to view graphs.  
 
Make sure you are on a frequency graph. Use <F7> to switch the view from 
percentages to counts. You should see consolidated totals. 
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4. Saving and Re-using Templates 
Goals for this Chapter 

This chapter is a review of saving and loading templates. 

Saving Templates 

You ran your meeting and it was so successful you intend to reuse its 
components in the future. So you wisely decide to save some templates. 
Here is how: 

Save Templates of List Processing Criteria 

Say you want to save the criteria you used for evaluating the work 
climate factors. 

1. Open the HR Initiative (Master) Meeting 

2. Highlight the agenda topic that you want to use. 

3. Press <F12> to get to the Criteria Pick List. 

4. Either press <Ctrl+Shift+T> or on the Edit menu, click Save 
Criterion as Template. 
 
This brings up the Template dialog.  

5. Place the template in the "Favorite Templates" user folder. 

6. Save the second criterion as a template too. 

7. Press the <Ctrl+Home> HotKey to return to the agenda. 
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Save Exercise Templates 

Suppose you want to save the whole "Work Climate" exercise as a 
template. 

1. At the agenda, highlight the "Work Climate" topic and press <F12> 
to bring up the Criteria Pick List. 

2. Select the File pulldown menu option Save as Template to save the 
exercise design as a template. 

3. Press <Ctrl+Home> to return to the agenda. 

Save Meeting Templates 

The meeting was so good you decide to save the whole meeting as a 
template. 

1. From the File menu, select Go to the OptionFinder Database. 

2. Click on the Master meeting tab and select the Save As action, then 
click the Apply button. 
 
The Save the <Name> Meeting Folder As dialog appears. 

3. Under New Folder Type, click Meeting template. 

4. Select "Favorite Templates" as the user folder in which to store the 
template, then click OK. 

Re-using Templates 

Of course, saving templates is only useful if we can use them later. In 
this section, you will retrieve or "load" some templates that have been 
saved. 
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Load Meeting Templates 

First, let's load the meeting template you just made. 

1. Go to the OptionFinder database. 

2. Click the Select tab, and then click on the Meeting Add button to add 
a new meeting. 

3. At the New meeting dialog, select the Get a template method and click 
OK. 

4. At the Get a Meeting Folder Template dialog, select the user folder in 
which you stored the template (Favorite Templates). 

5. Select the meeting template you want to retrieve and give the folder a 
new name. 

6. Click OK to create the duplicate meeting from the template. 

To view the new meeting you created from a template, find the new 
meeting in the Meeting folder on the Select tab of the OptionFinder 
database, and click OK at the dialog. 

Load Exercise Templates 

How about loading the "Work Climate" exercise template? 

1. Return to your agenda. 

2. Press <Insert> to add a new meeting topic. 
 
The Agenda Topic Editor appears. 

3. Press the Template button. 

4. In the List templates for list, select the List Processing tool. 
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5. Select the template you want to use from the Existing templates list 
and click OK. 
 
You will have to give the file a new name since you already have the 
exercise in this meeting and you don't want to overwrite it. 

Load Criteria Templates 

How about loading the criteria templates? 

1. Return to your agenda and add a new meeting topic. 

2. Create a new tool and select List Processing; give it a descriptive 
name. 

3. Right click and select Go to Criteria Pick List. 

4. Click the Load Criterion Template icon (or use the Edit pulldown 
menu option Load criterion template, or press <Ctrl+T>). 

5. Bring in your templates. 
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5. Navigating Graphs 
Goals for this Chapter 

This chapter reviews the basic procedures for navigating among the 
various graph views in OptionFinder. 

Understanding the Basic Graph Types 

There are many ways OptionFinder can graph the response data you 
have collected. The following are the graph types that are used the most. 

Frequency Distribution Graphs (<F2> HotKey) 

A frequency distribution shows you how many people choose each 
response choice for a particular question or list item. You can view a 
frequency graph by pressing <F2>. Once you are looking at a frequency 
distribution, you can press your <arrow> keys to move to the graphs for 
other questions, list items, or grouping dimensions, in the same exercise.  
Use letter keys to jump directly to another Frequency graph. 

Frequency Distributions for Subgroups of the Audience (<subgroup 
number> HotKey) 

If you have used the Groups tool to put participants into subgroups for 
one or more grouping dimensions, you can look at the frequency 
distributions for a particular subgroup, one subgroup at a time. Here's 
how to do it: 

1. Make sure the grouping dimension you want is loaded. 
 
Check the right side of the graph screen. 

2. If there is no grouping dimension indicated, or you want to load a 
different one, press <Ctrl+G>. 
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3. Highlight the grouping dimension you want and press OK. 
 
Notice that the grouping dimension is indicated at the right of the 
graph. 

4. To look at the responses of just the members of the first subgroup, 
press the number <1> on your computer keyboard. 
 
Notice that the Group label on the right side of the screen has changed 
and now lists a specific subgroup within that group, filtering out the 
other participant data. 

5. To look at the responses of the next subgroup, press <2>. 
 
Remember when you built the Group polling screen? The possible 
subgroups ("Sales and Marketing," "R&D," etc.) were numbered. The 
number for a particular subgroup on the polling screen is the number 
you press at the graphs to see that subgroup's responses. (It was also the 
same number the participants pressed on their keypads to "log in" to the 
subgroup.) 

6. To bring back the graph of the whole audience's responses, press 
<0>. 
 
Zero is always reserved to display the responses of the whole audience. 

7. To switch to another grouping dimension, press <Ctrl+G>, highlight 
the grouping dimension, and press <Enter>.  

Averages for All List Items or Questions (<F1> HotKey) 

An averages graph shows the average response of all the participants to 
each question or list item in the exercise that has been polled so far. 
When you are looking at any graph, press <F1> to display the averages 
graph. These are often called "anchor" or "summary" graphs because 
they show the whole picture. 

Averages only make sense on questions whose responses choices are 
in the form of a scale. 
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Understanding Standard Graph Navigation Techniques 

Usually, when you use OptionFinder, you will be looking at only a few 
graphs: frequency distributions and averages graphs. If you can get 
comfortable moving back and forth between these kinds of graphs, you 
will most likely be able to do everything required for your meeting. 

Practice using your letter keys and arrow keys to move from one 
frequency distribution to another. Then practice switching from a 
frequency graph to an averages graph by pressing <F1>. From an 
averages graph, practice pressing a <letter key> to go to the frequency 
distribution of a particular question or list item. 

When you master this, you should be in very good shape. For a full 
listing of the entire graph HotKeys, refer to the pull down Help, Contents, 
Index tab. Type in "HotKeys" and select "for navigating among graphs." 
Note that other HotKeys are listed in the same place. 

Bringing Up Graphs of Earlier Exercises 

There will be many times when you want to bring up the graphs from an 
earlier exercise. 

1. Highlight the agenda topic. 

2. Press <F9> to bring up graphs.  

Once you are viewing a graph, you have easy access to all the other 
graphs in that design file. 
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6. Backing Up and Restoring 
Goals for this Chapter 

When you have finished running the meeting with the real audience and 
have produced data too important to lose, you should make a backup of 
the meeting folder onto a floppy disk or onto a network drive for 
safekeeping. 

Backing Up an OptionFinder Meeting 

When OptionFinder backs up a meeting, it makes a copy of the meeting 
folder, compresses it, and stores it in a location you designate, typically a 
floppy disk or a network drive. Your original meeting folder and its 
response data will still be on your computer.  

1. If you are still in your meeting folder, bring up the OptionFinder 
database dialog. 

2. Select the meeting folder you want to back up. 

3. Click the Meeting tab, choose the action Save As, and click Apply. 

4. Choose Compressed meeting backup as the New Folder Type. 

5. Select the drive you want to back up this folder to. 
 
OptionFinder by default is ready to back up onto your "C:" drive. 
Change the Drive control to (-a-) if you want to back up to a floppy 
disk in drive A: 

6. Be sure all the "include" options are checked. 

7. When everything is correct, click OK.  
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Restoring a Backed-up OptionFinder Meeting 

If you have used OptionFinder to back up your meeting, you must use 
OptionFinder to restore it as well. 

1. Go to the Select tab in the OptionFinder Database dialog. 

2. Click the Add button for meetings.  The Add a Meeting dialog 
appears. 

3. Choose Restore a Backup as the method and click OK. 

4. Select the drive where the backup is stored, and then select the user 
folder if necessary.  
 
Note: If you backed up to a floppy disk or network directory where no 
user folders existed, OptionFinder creates a dummy user folder named 
"BAK." 

5. Give a name to the meeting folder you are about to create. 
 
If you already have a meeting folder with the same name on your 
computer, OptionFinder will stop you. You will have to use a different 
name or delete the existing meeting.  

OptionFinder decompresses the backed-up meeting folder and copies it 
onto your computer. The backed up version of the meeting still exists in 
the storage area you accessed it from. 
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7. Using HotKeys and Icons 
Goals for this Chapter 

You have now worked your way through the basic features of 
OptionFinder. There is a lot more to learn and we encourage you to 
explore with the User Guide, the on-line help system, and through 
training classes. Anytime you find yourself thinking, "I wish OptionFinder 
could do this," make the assumption that it can and either look for it on 
your own, or call us to find out how. Remember, practice may not make 
perfect, because every meeting is different. But practice sure helps.  In 
this chapter, we will review the HotKeys and icons that you will most 
commonly use as you gain experience with OptionFinder. Have fun! 

OptionFinder HotKeys 

The following chart shows just some of the HotKeys you can use to help 
you work with OptionFinder in Showtime mode. 

HotKeys for Editing and Defining Text 

HotKey Represents   HotKey Represents 

<Ctrl+U> 

 

Underline the blocked text or 
toggle underlining on/off for 

the next character 
  

<F11>
Color the blocked text or 

select a different color for the 
next character 

<Ctrl+B> 

 

Bold the blocked text or 
toggle bold on/off for the next 

character 
  

<Alt+>>
Increase the Font Size for all 
text in the current area of the 

screen 

<Ctrl+I> 

 

Italicize the blocked text or 
toggle italics on/off for the 

next character 
  

<Alt+<>
Decrease the Font Size for all 
text in the current area of the 

screen 
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Other Useful HotKeys for Editing Text 

<click & drag> Block text  
<Ctrl+C> Copy blocked text to the Windows clipboard
<Ctrl+X> Cut blocked text to the Windows clipboard
<Ctrl+V> Paste the contents of the Windows clipboard at the insertion point 
<Ctrl+G> Change the case of blocked text (to all upper or lower case)

<Ctrl+Del> Clear (erase) all text in the current area of the screen
<Home> Go to the beginning of a line of text
<End> Go to the end of a line of text

<Arrow> Go up or down one line in the current area of the screen
<Ctrl+Arrow> Go left or right one word

<Tab> Go to the next area of the screen
<Shift+Tab> Go to the previous area of the screen

<Shift+Enter> Force a new line of text (instead of waiting for word-wrap)

OptionFinder Icons 

OptionFinder Icons for Creating or Managing an Exercise 

Icon Represents   Icon Represents 

 

Create a new OptionFinder 
exercise   

 

Define the 
keypad system 

(number of 
pads, ports, 

brand, model) 

 
Open an existing exercise   

Test the 
keypads for 

proper function 

 

Save any changes made to 
the current exercise   

 

Add something 
to the current 

screen 
(agenda topic, 

list item, 
criterion, 
question) 
<Insert> 

Icon Represents  Icon Represents 
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Purge test data from all 
exercises attached to topics 

in the current agenda 
  

 

Define the 
overall Look & 

Feel for the 
meeting 

(colors, fonts, 
timers & 
counters) 

 

Create, read or edit a note 
about the exercise file 

<Ctrl+N> 
  

 

Bring up the 
editor so 

changes can 
be made 

(agenda topic, 
list item, 
criterion, 
question) 
<Enter> 

 

Print data for the current 
exercise 
<Ctrl+P> 

  
 

Bring up the 
Behaviors 

dialog for the 
current 

selection 
(question, the 
list, criterion, 

agenda) 
<Ctrl+F8> 

 

Go to OptionFinder 
Database to switch to a 

different meeting folder (or 
to work on folders in your 

database) 

  
 

Bring up the 
Behaviors 

dialog for the 
current 

exercise to 
define the 

sequence of 
events 
<F8> 

 

Go to the exercise linked to 
the selected agenda topic

<F12> 
  

 

Bring up the 
Behaviors 

dialog for the 
current 

exercise to 
define what 

graphs to show 

 

Bring up context-sensitive 
help for the current 

selection (dialogs) or view 
(audience screens) 

<F1> 

  
 

Go to the 
Criteria Pick 
List (when 

working with a 
list processing  

Icon Represents   Icon Represents 
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Load a previously saved 
template (agendas, criteria, 

response choices, etc.) 
<Ctrl+T> 

  
 

Go to The List 
view (when 

working with a 
list processing 

exercise) 
<F11> 

 

Close the current window, 
saving any changes if they 

have not been saved 
already 
<F2> 

      

 

Move the current selection 
up one position (agenda 

topics, questions, list items, 
criteria) 

<Ctrl+Up arrow> 

  
 

Move the 
current 

selection down 
one position 

(agenda 
topics, 

questions, list 
items, criteria) 
<Ctrl+Down 

arrow> 

OptionFinder Icons for Running a Session (Showtime Mode) 
 

Icon Represents   Icon Represents 

 

Run a TurboQuestion (bring 
up a blank question screen 
for an unplanned question)

<Ctrl+Q>

  
Display graphs for the 

selected exercise 
<F9> 

 

Hide the screen (blank out 
the whole screen) 

<Ctrl+H> 
  

Toggle between Showtime 
mode (where screens don't 

have menus, etc.) and 
Design mode (where the 

Windows interface is 
available) 
<Ctrl+M> 

 

Run (usually poll) the next 
scripted event in the selected 

exercise 
<F10>

      

 
 

Permission is granted to reproduce the content contained herein, as long as no 
content is altered and reference to the following copyright notice is included. 
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